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Introduction
These release notes describe a number of improvements in the Adlib
executables, which are implemented in Adlib 7.3. This release is available from April 2016 to all customers with a support contract and can
be downloaded from the Adlib website.
See the Designer 7.3 release notes for information that is largely limited to using Designer or which has been described more from the
application manager’s perspective.
You can simply install this software on top of your existing Adlib system (for versions 4.4 and higher). So you do not need to uninstall
anything, but please make a backup of your databases and applications first.
From Adlib 5.0 a new license file is used: adlib.lic. If you are already
using 5.0 or higher, you can use this upgrade immediately after installing; your license file has already been renewed, is in the right
place and will not be overwritten by the upgrade. When you install this
upgrade over an Adlib version that is older than 5.0, then the following applies: if you receive this release on CD or USB flash drive, then
on it you’ll find the proper license file; if you downloaded this release,
then e-mail our helpdesk (ALM.UK.helpdesk@axiell.com) for the necessary password and your license file. Place this file (you can make
copies of it) after installation of the upgrade in your Adlib \bin and
\tools or \executables or \Adlib folders (if present). The point is that
the license file should be located in the same folders as your Adlib
.exe files. How these folders are named is not important.
The release notes of previous major releases and service releases can
be found on the Adlib website.
 Backwards compatibility warning
New functionality in Adlib 6.6 for SQL Server and Oracle databases
makes records that you change with this version or newer versions
inaccessible to older versions of Adlib (adlwin.exe as well as
wwwopac.exe). Please, keep this in mind if you would first like to try
Adlib 7.3 before making the definitive upgrade. This limitation does
not apply to CBF databases.
This means that you have to update wwwopac.exe to 7.3 too (this
requirement does not apply to wwwopac.ashx). This may have consequences for your web application though because of some changes in
the structured XML-format: previously, empty fields from field groups
did not appear in the record XML, while from 6.6 they do.
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You also need the latest version of Adlib Designer to implement functionality described in these release notes. However, when you use the
new version of Designer to set up functionality that is introduced with
7.3, you won’t be able to edit that application or parts thereof, any
more in older versions of Adlib Designer. To be precise: if you apply
new settings in a database stucture (.inf file), then that file can only
be read by Adlib Designer 7.3, by the Adlib executables 7.3 and
wwwopac.ashx 7.3. Should you want to go back to an older version,
you’ll first have to deactivate your 7.3 settings in Designer 7.3: after
that, you should be able to open the relevant .inf in the older version
of the software again.
When you are updating from a software version older than 7.2, please
also see the release notes for version 7.2 (and possibly older versions)
for more important information about backwards compatibility.

30-5-2016
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1 New functionality
1.1 Link overviews
The new link overview functionality in Adlib offers a special display
showing from which databases and fields the current record (often an
authority term or name) is referenced. You can use this functionality
to quickly find out where a term or name is being used, which comes
in handy when you’re planning to clean up your thesaurus for example.

The Link overview button in the View menu in Adlib only becomes
active in detailed display mode of a record if for the current database
feedback databases have been specified. All model applications 3.6 or
later have these feedback databases by default, while older applications may have been customized with this feature.
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By default, the Link overview only displays the numbers of the records
in the other database, which reference the current record, like the
screenshot below for example, which shows that the object_category
field in records 1, 2, 3 (amongst 34 others) of the listed feedback database has a link to the currently displayed record.

However, you or your application manager may change which information will be displayed per record, to make the overview more useful. So instead of "record: #" you could choose to display the record
number, followed by the title of the record and the first registered
object name - all fields separated by forward slashes - for the COLLECT feedback database, for instance, as can be seen in the screenshot at the top of this chapter. Please see the Customizing the link
overview functionality Designer release notes topic for information
about how to do this.
The Link overview window pane initially opens on the left-hand side of
the Adlib window, but you can drag it (by its title bar) to any other
location. Or right-click the window pane and select Dock right in the
pop-up menu to move the window pane to the far right. You can also
resize the window pane by dragging one of its borders.

By default, the Link overview lists all feedback databases that have
been registered for the current database and for each of those all
fields that link to the current database, even if there are no references
to the current record in those fields or databases: (0) behind a
database name indicates that it has no references to the current
record. Since you might not be interested in seeing feedback
databases or fields which have no reference to the current record, you
can hide them all at once by selecting Hide empty fields in the rightclick pop-up menu. (Vice versa you can show them again by selecting
Show empty fields in the same menu.) Your pop-up menu choices will
be remembered by Adlib for next time you open the Link overview.
Note that the displayed feedback database and field names are their
system names, not their user-friendly names.
30-5-2016
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Besides the possibility to have some record information in the Link
overview, there’s the Designer option to set a detail zoom screen for a
linked field (again, see the Customizing the link overview functionality
Designer release notes topic): this allows you to double-click any of
the listed records (for the relevant linked field) in the Link overview in
order to open it for display (not editing) in a zoom screen so you can
view much more of the relevant record details.

Since such a detail zoom screen will have to be set per linked field and
there may be many linked fields in quite a number of feedback
databases, there’s a good chance you or your application manager will
only implement this double-click zoom screen viewing for a limited
number of fields.

1.2 Empty a field with Ctrl+T
To quickly empty the field that has the cursor in it, you can now also
use the Ctrl+T key combination (besides the already existing Empty
field option in the Edit menu). It only empties the current field occurrence: any other fields and occurrences in the field group remain unchanged. (Ref.no: 6846)
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1.3 Printing multilingual data via Word templates
From Adlib 7.3 you can print multilingual data (SQL databases only),
per language, via Word templates. This is to say that you can use the
field reference in a Word template to specify which language value
must be printed. You can provide a specific data language via an IETF
language code* like nl-NL for Dutch or en-GB for British English for
instance, or no data language at all to print data in the currently set
data language in Adlib.
In a field reference in a Word template it simply comes down to being
able to specify not only an occurrence number but a language code as
well, <<OB[2,en-GB]>> for example to print the English value of the
second occurrence of tag OB. Both arguments are optional: you may
specify just an occurrence or only a language code, like <<title[nlNL]>>.
* In Adlib Designer you can find any language code quickly by scrolling through the Data languages list on the Advanced tab of a selected
application structure (.pbk file).

 Examples
Below you’ll find some examples to clarify things. Suppose you’re using a multilingual database in which you can enter both Dutch, English
and French data in the Object name and Title fields. As usual, you can
select a data language via the Data language button in the Edit menu.

30-5-2016
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Then assume you have a record containing two object names and a
title in all three languages, for example:
Example data
(nl-NL)
Object name (occurrence 1): tekening
Object name (occurrence 2): topografische tekening
Title: Tekening in pen en penseel, voorstellende de Grolsteeg te Harderwijk, door Joh. van Bijsterveld, 1965
(en-GB)
Object name (occurrence 1): drawing
Object name (occurrence 2): topographic drawing
Title: Drawing in pen and pencil, representing the Grolsteeg in Harderwijk, by Joh. Van Bijsterveld, 1965
(fr-FR)
Object name (occurrence 1): dessin
Object name (occurrence 2): dessin topographique
Title: Dessin a la plume et au pinceau, représentant la rue Grolsteeg
à Harderwijk, par Joh. van Bijsterveld, 1965

Below you can see an example template which experiments with the
different possibilities of explicit or implicit printing of a language value.
(The four table cells automatically print all occurrences.)
Example template
Tag OB: <<OB>>
Tag OB[2]: <<OB[2]>>
Tag OB[fr-FR]: <<OB[fr-FR]>>
Tag OB[2,en-GB]: <<OB[2,en-GB]>>
Field object_name[1,fr-FR]: <<object_name[1,fr-FR]>>
<<object_name>>

<<OB[en-GB]>>

Tag TI: <<TI>>
Field title[1]: <<title[1]>>
Tag TI [fr-FR]: <<TI[fr-FR]>>
7
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Tag TI [1,en-GB]: <<TI[1,en-GB]>>
Field title[1,nl-NL]: <<title[1,nl-NL]>>
<<TI>>

<<TI[en-GB]>>

The result if the currently set data-language is Dutch:
Printing result
Tag OB: tekening
Tag OB[2]: topografische tekening
Tag OB[fr-FR]: dessin
Tag OB[2,en-GB]: topographic drawing
Field object_name[1,fr-FR]: dessin
tekening
topografische tekening

drawing
topographic drawing

Tag TI: Tekening in pen en penseel, voorstellende de Grolsteeg te
Harder-wijk, door Joh. van Bijsterveld, 1965
Field title[1]: Tekening in pen en penseel, voorstellende de Grolsteeg te Harder-wijk, door Joh. van Bijsterveld, 1965
Tag TI [fr-FR]: Dessin a la plume et au pinceau, représentant la rue
Grolsteeg à Harderwijk, par Joh. van Bijsterveld, 1965
Tag TI [1,en-GB]: Drawing in pen and pencil, representing the Grolsteeg in Harderwijk, by Joh. Van Bijsterveld, 1965 (en-GB)
Field title[1,nl-NL]: Tekening in pen en penseel, voorstellende de
Grolsteeg te Harder-wijk, door Joh. van Bijsterveld, 1965
Tekening in pen en penseel, voorstellende de Grolsteeg te Harder-wijk, door Joh. van Bijsterveld,
1965

30-5-2016
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Drawing in pen and pencil, representing the Grolsteeg in Harderwijk, by Joh. Van Bijsterveld, 1965
(en-GB)
(Ref.no: 4984)

1.4 Search forms with a preset search statement

As you may know, Adlib offers three ways to put together a search
query: via the Search wizard, via a Search form (aka Query by form)
in the Start menu or via the Advanced search. In a Search form you’ll
enter search keys in one or more fields, with which Adlib will create a
(combined) search statement in the background.
From Adlib 7.3 – you don’t need a new version of Designer – Adlib is
able to add a hidden, partial search statement (which has been set on
the search form earlier by the application manager), to the search
statement which has been put together implicitly by the user via the
relevant search form. This has the advantage that search forms can
be created for a specific use. In the Query by form Archives in the
Archive (catalogue) data source for example, you could set up a partial search statement to make sure that the search form is always
used to search on the item description level. In the Query by form
Object in the Internal object catalogue on the other hand, you could
specify the condition that the form will only search for objects on a
certain location or after a certain historical acquisition date, for example.
9

30-5-2016

New functionality

Adlib 7.3

The partial search statement must be set in the properties of a search
form which you have opened in the Designer Screen editor, on the List
fields tab. At the top of the Tag list, enter the new AddToQuery parameter. Next to it, as the English Text value, enter the desired partial
search statement: that search statement is of the Advanced search
type but should always start with a Boolean operator (AND or AND NOT,
the other operators aren’t very useful) because in the end Adlib must
be able to create a combined search statement of it.
 Example:
1. In an XPlus model application 4.2 there’s a Query by form Collection available in the Internal object catalogue data source. Let’s
add a fixed search statement to that search form.

2. In the Designer Application browser, open your application structure and beneath it the Internal object catalogue. Then open the
Methods list > Query by form Collection > Screens and doubleclick Query by form Objects to open the screen in the Screen editor.

30-5-2016
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3. Right-click an empty spot in the opened search form and choose
Properties in the pop-up menu which opens. Then on the List fields
tab, underneath Tag, fill in the AddToQuery parameter and type
your search statement behind English in the list on the right.

Of fields, provide the tag or the English field name. One of the
ways to find those is by right-clicking the desired field in Adlib,
select Properties in the pop-up menu which opens and in the Field
properties window look up the relevant details on the Data
dictionary tab.
11
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4. Close the properties window, save the changes in the screen,
restart Adlib en observe the consequences when you perform a
search in Adlib, using the relevant search form. Suppose you’re
searching for Object name: painting, then Adlib will really search
with object_name = painting and current_location =
Amsterdam.

If the user doesn’t enter any values, the search will proceed with
the fixed search statement only. In this example that would be:
(and) current_location = Amsterdam.

1.5 Moving objects to their normal location
The Change locations procedure allows you to simultaneously change
the Current location of one or more marked records in the Brief
display. This is handy if a part of, or all of the collection changes location and you have actually moved the objects. For marked records you
can start this function by clicking the Change locations button in the
Edit menu.
The Change object locations window opens and from Adlib 7.3 this
window also contains the new To normal location option at the top of
the form, if you are using a model application 4.2 or higher. By
marking the checkbox, this procedure allows you to change the
current location of the marked records all at once to the normal
location as registered per record. The Location field in this dialog can
30-5-2016
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no longer be filled in once you mark the To normal location checkbox.
(In other words: the marked checkbox makes sure that the location
registered in the Normal location field in the marked records, will be
copied to the Current location field. No changes will be made to the
value registered in the Normal location field.)

If one or more of the processed records does not have a Normal
location (tag NL), then those records will be skipped and you will be
notified so. Other records that do have a normal location will be
processed as you would expect.

The messages which appear in the Summary box can be selected with
the mouse or with the (right-click) pop-up menu and copied to a text
13
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file, so you can save them for possible verification afterwards.
(Ref.no: 5742)

1.6 Adjustments to the Record information window
The Record information (Ctrl+R) window (primarily meant for debugging purposes, to show all contents of a record in detailed display at
once), can now be resized: move the mouse pointer to the edge of the
window so that the mouse pointer changes into a double arrow, then
click and hold the mouse button down while you drag the window’s
edge.

If you can’t read all text in the Data column because the data in a field
is too long for the column, you can widen the Data column after
you’ve widened the window first: move the mouse pointer to the right
edge of the label of the Data column until the mouse pointer changes
into a black double arrow, then click and hold the mouse button down
while you drag the label’s edge.

The tooltip which appears when you hover the mouse pointer over a
row in the window, is meant for debugging purposes as well. It concerns information about whether the indicated field has currently (in
edit mode) been edited or not, whether a linked record has already
30-5-2016
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been created for new values in linked fields, whether a linked value
has been “resolved” or not, whether it concerns a temporary field
which should not be stored and whether the value in the field has
been locked or not.

1.7 Playing media streams in the Media Viewer
When the Retrieval path option for an image field has been set to a
URL to an online service which may serve image files and other static
media files as well as streaming video, Adlib 7.3 will first try to get the
file type of the media reference in the current record from the server,
before displaying anything. If it succeeds, Adlib will download the file
if it is a static file or stream the streaming media to the Adlib Media
Viewer. If the type can’t be determined, Adlib will only try to download
the file.
(Ref.no: 7063)

1.8 More information in ADAPL messages
Adapls are being executed in the background at different times in
Adlib. Such an adapl sometimes generates a message on the screen,
via an ERRORM statement. It usually explains clearly why your attention is required, but until now there was no easy way to find out which
adapl generated the message. That has changed in 7.3. In the left
bottom corner of each ADAPL message you’ll now find the Show details option. Click the option to display the name and location of the
relevant adapl. This can be useful if you’d like to view or edit the adapl
(the .ada version of the displayed file), for example to check whether
an error is generated appropriately or to change the message.
Note that not all messages are generated by ADAPL, most of them
come from adlwin.exe.
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(Ref.no: 7051)

1.9 Quickly entering a barcode in the change locations procedure
In the change locations procedure, there’s a quicker way now to enter
a location based on a barcode to be scanned. (From model application
4.5, barcodes are registered in a separate field.) First put the cursor in
the Location entry field in the Change object locations window. (You
open this window for marked object records by selecting the Change
locations option in the Edit menu.) Scan the desired barcode and note
that it is entered in the entry field.

As soon as you leave the entry field or fill in other fields, the location
name associated with the barcode will be retrieved by means of that
barcode. The barcode in the entry field will be replaced by the location
name, but the barcode will still be displayed underneath the Location
entry field.

30-5-2016
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In the Location entry field you can still just type the name of the desired location as well. This will also be validated and if it exists, it will
be repeated underneath the entry field.
Should Adlib not be able to find the entered name or barcode in the
linked Locations and containers data source, then still the Find data
for the field window will open, allowing you to search for the proper
location name or barcode: in the Find drop-down list you will have to
indicate whether you’d like to search on name or barcode, though.
(Ref.no: 6625)

1.10 Overridable executor in the change locations
procedure
To be able to specify any executor during the change locations procedure – for marked object records, select the Change locations option
in the Edit menu – the Executor entry field has been added to the
Change object locations window. Previously, by default the name of
the currently logged-in user was taken as the name of the executor,
the person executing the change location procedure in Adlib. In the
new situation that is still the case if you leave the Executor entry field
empty during the procedure: only if you enter data in the entry field
(a different name), that name will be included as the executor of the
move. This way there’s no need for the actual executor of the move of
objects to be the person registering that move in Adlib.
By the way: the Executor field is only present by default on the Location | Future movements and Location history screens, from model
application 4.5

17

30-5-2016

New functionality

Adlib 7.3

1.11 New handling of obsolete terms and names
Previously, when you assigned a term or name in the Thesaurus or
Persons and institutions the Status obsolete or rejected, this had no
further consequences for the handling of that term by the Adlib
software.

30-5-2016
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From 7.3 however, the following applies:
1. Terms and names with the obsolete or rejected status won’t be
displayed in the Find data for the field window for linked fields.
That way you won’t accidentally pick a term here which shouldn’t
be used anymore.
2. Obsolete terms and names can still be used though and existing
records with the term or name will remain unchanged and they
won’t generate any messages either.
However, when you enter the term or name anew in a linked field,
you’ll get to see the warning below. Click Yes to accept the
entered term, here in this field in this record, for what it is or click
No to delete the entered term or name and place the cursor in the
relevant field again so that you may enter another term.
The next time that you newly enter the same term or name in a
field, the message will reappear. The message won’t show up if
you leave a field in a record in which the term or name had
already been entered earlier.

3. Rejected terms or names can no longer be entered in fields,
although existing records with the term or name will remain
unchanged and they won’t generate any messages either. When
you do enter the term or name in a linked field anyway, you’ll be
warned that the term can no longer be used. You can only click
OK, after which the field will be emptied automatically.
(Ref.no: 7079)
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1.12 Inheritable fields
From Adlib 7.3, your application administrator may have set up socalled inherited fields (see the Designer 7.3 release notes for more
information about that). This functionality allows you to automatically
display and possibly copy data from the accordingly set up fields from
the first record higher in the hierarchy in which these fields have
actually been filled in.
An example might clarify things: suppose you have an object record
for a "dollhouse" which has Parts (child records) describing the
contents of the dollhouse. And maybe some of those parts, like a
"closet (miniature)", may even have Parts of their own. If you are
registering such hierarchies regularly and you find you often need to
copy the contents of some field from the top record of the hierarchy to
its child records (or just be able to see its contents) – e.g. a
description that applies to all parts, like condition notes about the
dollhouse and its parts or some other notes relevant to all children –
then a mechanism for copying that content might come in handy. And
that is just what inherited fields do. Once set up for a field, every time
you view or edit a record with this field, Adlib will automatically look
upwards in the hierarchy (if present) to see if the parent record has
data in that field. If not, Adlib will check the grandparent (if present)
and so on, until a record has been found in which the relevant field
has been filled in. If so, Adlib will display its contents greyed out in the
same field of the current record, if it was still empty. Even though the
copied content is displayed in the record, it is not yet part of the
current record. To save the copied contents, put the record in edit
mode and simply double-click the relevant inhereted field or put the
cursor in the field and start typing new text and/or delete copied text
to fully activate the field contents (the text colour changes to normal).
Now saving the record includes the activated field contents: a quick
way to (partially) copy data from other records! Remember that
typing new text in such fields is possible as well, so you're not stuck
with the copied text.
Per field you can always choose whether to activate the copied
contents or not. If you don't want to duplicate data from the higher
records at all, you'll probably never activate the data and just enjoy
the fact that data from parent records is conveniently visible in the
record you are viewing or editing.
Do observe that inherited data may come from different elders: one
field might display data from the direct parent record, while another
field shows data from the grandparent record because the relevant
field is empty in the parent record too.

30-5-2016
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 Best practice example of working with inherited fields
1. If you know certain fields have been set up as inherited fields by
your application administrator and you are about to register a new
hierarchy of items, you profit most from data inheritance if you
start by registering the top item in the hierarchy and work your
way down. Below, you can see an example of such a top record in
a Museum application, for a dollhouse.

2. Next, register one of the parts of this dollhouse, a miniature closet
in this case. First thing to do when you create the child record is
to link it to its parent, like you would normally do on the Numbers
| Relationships tab.

3. As soon as you've created the link to the parent, the inheritance
functionality can do its thing. For this example, know that the
(Object name) Notes and Title field are the inherited fields. When
you switch back to the Identification tab, you'll see the Notes and
Title fields showing greyed out data copied from the parent record.
As long as this data is greyed out, it won't be stored in this record,
just displayed. If you do want to store the data in such a field,
simply double-click the field to activate the data: the text colour
will change to normal. You can also change the activated data by
21
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typing over it.

4. If you save the record without having activated any inherited data,
it won't be stored in the record but it will still show in display
mode. And child records of this "closet" will inherit this data too,
even though to those records the data must be inherited from the
grandparent.

 Notes


If multiple occurrences exist of a destination field for an
inheritable field in the current record, of which at least one has
already been filled in, then no inherited data will be shown in any
empty occurrences.



If the higher record contains multiple filled-in occurrences of an
inheritable field, then all those occurrences will be displayed in the
same occurrences of the destination field in the current record, on
the condition that all occurrences of that field in the current record
are still empty.

30-5-2016
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If at least one of the data languages in a multilingual destination
field already contains data, then no data will be inherited in any of
the languages.



Of multilingual inheritable fields, all translations will be inherited if
all data languages in the field in the destination record are empty.
For example, if the current record inherits English and German
data of a higher record, you’ll only see that data in the current
record if you’re viewing it in the English or German data language.
In the other languages you’ll see three dots in the field to indicate
that the field does contain data, just not in the current data
language.



If a multilingual destination field is empty and in one or more data
languages inherited data is being displayed, then that data will
become active as soon as you enter new data in a data language
in which no data is present in the field yet. Also if you edit one of
the inherited translations, the other inherited translations will
become active as well.

1.13 Go to field
From Adlib 7.3 you can quickly jump to any field on any screen in
detailed display of a record (without having to browse all your screen
tabs), using the Go to field functionality:
1. In detailed display of a record (either in display or edit mode)
press the new Ctrl+G key combination to open the Go to field dialog.
2. Start typing the first letters of the name of the field you are looking for. It concerns the field name as it is registered in the database definition (which is often different from field labels on
screen), in the current interface language. So if the Adlib menus
are in English, type the English field name.

As soon as you start typing, the auto-complete function fills in the
first suggestion. It consist of a field name, a colon and a screen
label. In the example above, we’ve just entered ob.
23
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3. From here, you may continue in the following ways:
- if the auto-complete suggestion is what you were after, just click
OK to jump to the relevant screen. If your record is in edit mode,
the cursor will automatically be located in the proper field too.
- or open the drop-down list by clicking the arrow, select the field
and screen you’d like to jump to and click OK.

- instead of opening the drop-down list, you may keep on typing
until the desired field and screen are found by the auto-complete
function. After which you must click OK to make the actual jump.
- you may also type just the first few letters of the field name you
are looking for, possibly followed by a colon and the first few letters of the desired screen. Auto-complete won’t help out in this
case, but when you click OK, Adlib will try to match your entry as
good as possible. For example, for an object record, simply enter
rep:rep as the go-to field name and screen and click OK: you’ll
jump to the Reproductions tab immediately. If there are no other
fields than reproduction fields that start with rep, just entering
rep is enough too.
 Notes


If nothing happens after you’ve selected a field : screen combination and clicked OK, you’ve accidentally chosen a screen that
is not active in the current dataset (because of limited access
rights, for example).
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In display mode you’ll only jump to the proper screen, while in
edit mode you’ll jump to the desired screen and the cursor is
placed in the proper field (if it is editable).

(Ref.no: 7133)

1.14 Searching with the expand operator
Suppose you have a database with a hierarchical structure, an archive
for instance, and you would like to be able to execute searches with
which you hope to find not only a single specific record but all underlying records as well.
From 7.3 you can do so with the expand operator which can be used
in advanced searching and fixed queries. The syntax is as follows:
expand(<search statement>)
Take the hierarchy in the screenshot below, for example. If you’d like
to retrieve the record with reference BW/GG/M and all underlying records (child records, grandchild records, etc.) by searching on the
terms minutes board committees from the title, then execute the
following search statement:
expand(title = 'minutes board committees')

However, the expand operator does need an index on the link reference tag for the broader term field to function and many applications
do not have that yet. If you execute an expand search statement and
the error message below stops you in your tracks, you’ll know what
time it is. It’s easy to fix the problem though, if Adlib Designer is at
your disposal. The error message already indicates for which tag an
25
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index must still be created: in the example below that’s tag 1l but in
your case another tag might be applicable.

Proceed as follows:
1. Look up the relevant tag in the appropriate database in the Designer Application browser. (The object catalogues and archive datasets are often associated with the collect database, for example.
In the application definition you can find out which data source in
your application is associated with which database.) In the fields
list you can quickly locate the tag by sorting it alphabetically on
tag first: right-click the Fields label in the tree view and select Sort
by tag in the pop-up menu.
2. Now right-click the field you were looking for and in the pop-up
menu select the Create index option.
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3. First close the Reindexing <tag> for <database> window that has
opened a little prematurely. Then select the new index which has
been added at the bottom of the Indexes list in the tree view. Now
enter a better name for the index, so it becomes easier to recognize, prtofref for instance. Subsequently set the Key type to Integer and leave the other options as they were.

4. Click the Re-index button to reopen the Reindexing <tag> for
<database> window and in it, click the Start button. When
indexing has been completed you may close the window. The
index definition has already been saved in the database structure.
5. Close Designer, start your Adlib application and try searching with
the expand operator again (in the same data source). It should
function alright now.

1.15 Reverse links processing in a read-only linked
database
Suppose you have set tight access right to your databases to make
sure that some user group, let’s call their role “repromanagers” for
example, can only edit records in the PHOTO database (the Visual
documentation data source) and has read-only rights to COLLECT (the
objects data sources) while another user group, with role “objectmanagers” for example, has the opposite rights (allowed to write object
records while only being allowed to read reproduction records). Since
in current applications PHOTO and COLLECT are reversely linked databases – object records can link to multiple reproductions while each
reproduction record can link to multiple object records – this setup
27
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would previously cause problems because for any of these two user
groups the read-only access rights to the reversely linked database
would prevent new reverse links from being processed: after all, if I’m
allowed to edit a reproduction record and add a linked object, then on
saving this record, Adlib will try to add the current reproduction reference to the relevant object record (which strictly speaking isn’t allowed because I only have read-only rights to COLLECT).
To fix this problem, 7.3 implements a less strict policy in this regard:
it will ignore read-only access rights to reversely linked databases as
far as the processing of reverse links is concerned. So in the example
above, the “repromanagers” will be allowed to add linked objects to a
reproduction record, while the “objectmanagers” will be allowed to add
reproduction references to object records. Each user group will still not
be able to edit records in the other database though.
If the access rights need to be tightened even further, for example to
prevent the “objectmanagers” from adding reproduction references to
an object record, then you could protect the reproduction reference
field and its link reference field in the COLLECT data dictionary by
assigning the “objectmanagers” role read-only rights to these fields.
Then the only way to create reverse links between objects and reproductions would be if the “repromanagers” added linked objects to reproduction records. The reverse links would be processed automatically when saving a reproduction record and they would become visible
(read-only to both groups) in the relevant object records.
Note that although the example assumes two user groups with opposite rights, a setup in which only a single user group (role) needs to be
able to write reverse links in a read-only linked database, applies just
as well.
Also, the new funtionality only applies to Adlib for SQL databases. CBF
databases do not support this solution.
(Ref.no: 4894)

1.16 Adding child records in batch
From Adlib 7.3.16046.3 you can add multiple child records at once
underneath a selected record, via the pop-up menu in the Hierarchy
browser.
If relational rules* have been specified for the internal links which
form the basis of the displayed hierarchy, then those rules will be taken into account and you can only add child records of the record type
that is allowed for the currently selected record type. (*Please see the
”The record type field” and “Relationship dependency rules for internally linked record types” Designer 7.3 release notes topics for information about how to set this up.)
30-5-2016

28

Adlib 7.3

New functionality

When the requested child records are generated, the storage adapl set
up for the database will be executed normally to fill any mandatory
fields or certain desired fields automatically. Automatically numbered
fields in the new records will also be processed normally.
For the Adlib user it simply works as follows:
1. If you open a record in a hierarchically organised database and
display the Hierarchy browser (F9), you can view the complete hierarchy that the record is part of. Any record from the hierarchy
can be shown in detailed display by double-clicking the record.
2. The new functionality allows you to insert one or more largely
empty records underneath one of the listed records (on a lower
level that is). Any mandatory fields should** be filled automatically. Right-click the record underneath which you’d like to insert the
new records and choose Add child records in the pop-up menu
that opens.
3. The Add children window opens. Set the number of child records
you’d like to insert now.

The Type of children drop-down list is only active (allowing you to
pick a value from the list) if so-called relational (aka business)
rules for the internal links have been specified and if you are allowed to insert more than one record type underneath the selected record. In the example above those relational rules have been
set indeed but a series record can only parent a sub-series record,
which explains why the user is offered no other choice here. If the
29
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drop-down list is empty, it simply means no relational rules have
been set.
4. Click OK and the records will be created immediately and will be
added below the other child records underneath the selected record. The reverse links from child to parent and from parent to
children will be made automatically.
5. Double-click one of the new records to present it in detailed display. You can edit the record normally to add data where needed.
** It is of the utmost importance that you or your application manager ensures that mandatory fields in the hierarchical database will indeed be filled with data, for instance by adapting the storage adapl for
the relevant database or by setting up automatically numbered fields.
And if those mandatory fields are indexed uniquely, then the automatically entered values should be guaranteed unique too.
If these precautions have not been taken, Adlib will warn you about it
when you try to create child records: in that case, the child records
won’t be saved.

1.17 New “group” term status (neutral value 6)
From version 7.3, Adlib supports a new term status that has the neutral value 6 and display value group. The list of possible statusses
which can be assigned to a term in the thesaurus (or comparable authority file) thus becomes as follows:
Neutral value

Display value

0

undefined

1

approved preferred term

2

approved non-preferred term

3

candidate

4

obsolete

5

rejected

6

group

The group status is intended for terms which are useful or important
in your thesaurus management to distinguish term collections and
which themselves can be part of the term hierarchy but are not allowed to be used as a term in catalogue records.
An example might illustrate this concept. Suppose that in your thesaurus you’d like to construct a term hierarchy of body armour:
30-5-2016
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armour
armour (by construction)
mail armour
plate armour
scale armour
armour (by form)
cuirass
gambeson
gauntlet
helmet
leg guard
shoulder plate
armour (by function)
battle armour
horse armour
parade armour
Although the terms armour (by construction), armour (by form) and
armour (by function) come in handy here in the term hierarchy, you
would probably not want anyone to link to such a term from within the
catalogue (contrary to the other terms). Precisely for this purpose you
could assign the group status to the mentioned three terms in this
example (if the field definition of the status field has been adjusted
accordingly*).
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Terms which have been assigned the group status, adhere to the following specific rules:


Within the authority database you can link to such a term as a
broader or narrower term so you can include it in a term hierarchy.



Terms with this status will be indexed in the thesaurus and you
can search on them normally.



In catalogue records which link to the thesaurus you cannot store
terms with the group status in linked fields.



In linked fields in catalogue records which link to the thesaurus
you can use the Find data for the field window to look for terms
with the group status. In the list of found terms, terms with the
group status have been marked with a green, square icon: you
can mark these terms with the selection bar but only the nongroup terms from your selection can actually be copied to the
linked field.



Avoid using terms with this status in preferred term relations: you
won’t be using them in the catalogue anyway.

* Although Adlib supports the new term status from version 7.3, you
or your application manager must still add the new status to the field
definition of the enumerative status field in your authority database
before the Adlib user will actually be able to assign the new status via
the Status drop-down list in an authority record. For the term.status
(tag ts) field in the thesaurus, you simply add the value 6 to the Enumeration values list of the field in Adlib Designer while next to it you
provide the display values in the desired interface languages, e.g.
group as the English display value and groep as the Dutch translation.
Remember to save your changes to the database. (Ref.no: 7580)
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1.18 The Reset Media Viewer function
The Reset Media Viewer button in the View menu, which becomes
active when a record is in detailed display mode, allows you to restore
the size and position of the Media Viewer window to its default settings. This comes in handy if you had moved the Media Viewer outside
the current monitor screen boundaries earlier and now you’d like to
get it back.

If you had hidden the Media Viewer by closing it, then the Reset Media
Viewer function won’t bring it back: the Media Viewer button in the
same View menu is meant for showing or hiding the Media Viewer.
(Ref.no: 7592)
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1.19 Multiple hierarchies in the Hierarchy browser
Previously, the Hierarchy browser (F9) could only display a single hierarchy, even if a term was part of multiple hierarchies. Adlib 7.3 fills
that gap with the following improvements (which do not require any
setup in Designer):


If the currently displayed term has multiple broader terms (resulting in different hierarchies) then all of those hierarchies will now
automatically be displayed (below each other) in the Hierarchy
browser. Below you can see an example from the Thesaurus in
which the term ‘helmet’ is part of two different hierarchies. Both
hierarchies will be shown automatically for the currently displayed
‘helmet’ record.
Note that although the vertical, dotted line between ‘armour’ and
‘headgear’ may seem to indicate otherwise, there is no link between both terms: these are separate hierarchies.

You can also imagine (lucky pun) a record in Persons and
institutions being part of different hierarchies:
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If the currently displayed term is part of different types of hierarchical (broader/narrower) relations (which is possible in principle if
multiple internal link definitions of the hierarchical type have been
specified for the term or name field in the current database), then
all of these will be displayed in the Hierarchy browser.



If the currently displayed term has equivalent terms then any
hierarchies for those equivalent terms are displayed as well, below
any other hierarchies. And an equivalent term does by no means
have to be the top term of the hierarchy it is part of.
In the example below, ‘headdress’ and ‘headwear’ are equivalent
terms of ‘headgear’ and they are not part of some hierarchy of
their own. To indicate that these terms are equivalent terms of the
selected term (the record shown in detail), they are being displayed in bold red type.
If you have no interest in any equivalent terms and their hierarchies, you can hide them by right-clicking the Hierarchy browser
and selecting Hide equivalents in the pop-up menu. Similarly you
can show them again by selecting Show equivalents in the same
pop-up menu. Adlib remembers your setting (per user) for next
time you open the Hierarchy browser. In the screenshot below,
clicking Hide equivalents would hide de terms ‘headdress’ and
‘headwear’ (equivalents of ‘headgear’).

In Persons and institutions this functionality may come in handy
too if a person name has equivalents in the form of a nickname,
proper name or even writer’s aliasses.
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2 Other improvements
In 7.3 the following functionality has been improved as well:
Ref.no

Short description

4541

It wasn’t possible to search for all records using an empty
QBF, which could be a problem if you wanted to retrieve
all records from a database with no mandatory fields and
you had no other option than to use a search form.

4872

Repeated occurrences of deep link fields did not display
correctly: not all occurrences were displayed.

4946

The Add button in the Add to pointerfile window was active before a pointerfile was selected.

4961

The Change locations procedure didn’t offer the user the
hierarchical context of locations, so you could not be sure
that you picked the correct location if the location didn’t
have a unique name.

5079

The “favorites” functionality, as available in the right-click
pop-up menu for fields, made no distinction between upper and lower case in the field tags. This caused favorite
values for e.g. tag IN to be avalable for tag in as well.

5284

When switching from specific linked fields the screen was
redrawn needlessly.

5401

Inconsistent behaviour when clicking on internal links:
when you clicked on an internal link that lead to a record
which was not part of the current dataset, this record
should have been opened in a zoom screen. However, in
some applications the linked record opened in detailed
presentation, which lead to error 31 (Could not read record ... from database ...) when you tried to edit it.

5414

The F1 Help was only displayed when the Adlib window
was maximized.

5541

The All keys button in the Search wizard and the narrower operator in the Advanced search actually used the
terms of all narrower keys to search on, instead of the
prirefs of the narrower keys, which could cause the search
result to be larger than it should have been. This is relevant when the searched terms need not be unique, like
location names.
37
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5767

In the Find data for the field window of the Change locations procedure, the context of found terms wasn’t present, sometimes making it difficult to pick the proper
term.

5772

The cursor sometimes disappeared after selecting a linked
record in the Find data for the field window for a sorted
linked field.

6068

Hierarchical searching (with the Use relations checkbox in
the Search wizard marked) on current location produced
incorrect results: the search result was too large. (Also
see ref.no 5541.)

6165

When listing terms from the external AAT thesaurus, the
View hierarchy tab in the Find data for field window contained incorrect terms.

6237

Occurrences were not sorted when they had been added
from a linked database. For example: if you linked an
object record to an exhibition record and in the object
record were links to multiple exhibitions, then the linked
exhibitions in the object record were not sorted if the sorting was on start date.

6275

A field in a record in edit mode lost focus after using
Alt+Tab to switch back and forth between other applications.

6453

Performance of opening a screen tab containing several
thousand occurrences of some linked field was very bad.

6458

In Adlib Designer, the Save button wasn’t activated after
changing the Closed periods in Adloan parameters.

6598

One image in the Thumbnail and Filmstrip displays was
shown rotated, while dislayed normally in the brief display.

6646

After running the Change locations procedure in detailed
display of a record that had been opened from the brief
display, the user was returned to the detailed display of
another record, namely the first record in the result set.

6683

Using the Change locations procedure to assign a new
location to a record without any existing location information, created a useless location history occurrence
which was empty except for an end date.
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6765

When access rights of screens were set when the screen
was accessed using the Screens folder in the Designer
Application browser it was impossible to save the changes
because the Save button didn’t become active.

6787

An Advanced search like <field> contains '/' returned
all records, instead of just records with a slash in the field.

6807

Adlib Designer changes to library opening hours in the
adcirck.pbk couldn’t be saved because the Save button
didn’t become active.

6833

Reserved variable &6[7] was not updated after the user
changed the data source, so it always contained the name
of the first opened data source.

6854

When selecting fields for a sort order, a new field was
automatically placed directly below the first field instead
of below the last one.

6861

In a hosted application for which rights had been set, the
Change locations button wasn’t always active.

6875

There was no focus on the search result window after a
QBF search, so you couldn’t navigate the search result list
using the keyboard.

6876

The import job setting Make [default language] the invariant language set all language values in a field to Invariant.

6883

Occurrences of a field set up to be sorted descendingly
were displayed in the wrong order (ascendingly).

6920

An adlwin.exe import of an Adlib tagged file containing
multiple occurrences of some field, only imported the last
of those occurrences (by repeatedly overwriting the earlier
imported occurrences).

6924

Using the arrow keys in a grouped field made adlwin.exe
crash.

6925

After performing the Change locations procedure on a
single object record which was not the first record in the
result set listed in the brief display, the first record from
the result set was displayed instead of the processed record.

6928

A default value for a field in a repeated group was only
entered in the first occurrence (instead of in all occurrenc39
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es) when a record set from a pointer file was linked to the
linked field in this repeated group.
6929

When you tried to copy enumerative field contents via the
Copy option in the right-click pop-up menu for the field, it
wasn’t copied at all or copied incorrectly.

6931

Import.exe did not always produce all occurrences in a
multilingual XML import.

6940

Searching on a merged-in ISO date field with an ISO date
index returned an error: error converting data type nvar
to numeric.

6942

Adlib generated a common runtime error after rightclicking a text field with a lot of data.

6943

A crash or undocumented error 369 occurred when clicking on a pointer file while the list of pointer files was not
completely displayed yet.

6945

Not all images on the Thumbnails tab of the brief display
were reloaded after the screen had refreshed.

6946

Step 4 of the Search wizard sometimes showed keys from
earlier searches that didn’t yield any results, amongst the
keys from the index currently searched.

6953

Adlib generated an error 176 for a combined index field
when saving a new use-relation in a thesaurus record.

6960

It was impossible to print the contents of a context field to
a Zebra label printer.

6968

If you wanted to add a second occurrence to a linked field
using a Query by form, then the content of the first occurrence was displayed in the QBF.

6969

The display of images on the Thumbnails tab of a search
result was not always correct if the orientation of the image was stored in the EXIF metadata of the image.

6971

Printing multiple records using a Word template stopped
when processing the second record, closing both the Word
template and the already created first Word document.

6975

If you derived a record and did not save it, the original
record was removed anyway (if set up to be removed on
saving).
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6981

To the automatically generated HTML, after entering data
in an HTML field, a <BODY> node was added which broke
the earlier determined output format of this field.

6984

A default value for a field in a repeated group was only
entered in the first occurrence (instead of in all occurrences) when a record set from a pointer file was linked to the
linked field in this repeated group.

6987

When your Adlib shortcut used the –datadir launch option, the data folder could not be found any more.

6993

When a context field had been added to a link screen, the
contents of this field were never displayed.

7004

The WHEN operator in advanced search statements would
always return 0 hits, even if there were records that satisfied the conditions.

7012

Images on the Thumbnails and Filmstrip screen tabs of a
search result weren’t displayed when retrieved via a URL.

7021

In some applications, marking the Use relations option for
a selected access point would cause an empty line in the
list of found keys. Clicking it would return a message that
no records were found.

7022

The Find records for <field> = <value> option in the
right-click pop-up menu for indexed fields, was inadvertently disabled for a certain role.

7024

A screen condition always hid the screen, regardless of
the condition result.

7029

After pasting a large amount of text from the Windows
clipboard, Adlib switched to another record leaving a nonworking lock on the original record.

7031

Images on the Media Viewer Thumbnails and Filmstrip
tabs were not displayed until you clicked the relevant
thumbnail.

7038

When doing a second search and opening the brief screen
again, Adlib would throw an exception and write a stack
dump file.

7039

Step 4 of the Search wizard didn’t always show narrowers
of found terms.

7052

Pressing the Tab key from a linked field opened the Find
data for the field window, but cleared the linked field be41
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forehand, so the Find data for the field window displayed
the first term in the list instead of the term matching the
value originally entered in the linked field.
7057

When an advanced search statement was being executed,
the progress window could be placed in the background,
behind the Advanced search window.

7058

In display mode it was not possible to copy a value from
an enumerated field to the Window clipboard.

7059

When an enumerated field contained a non-defined value,
a language value could still be displayed.

7060

The Replace in record function didn't read the value in an
enumerated field properly. When an enumerated field
contained a value which was neither a neutral value nor a
language value and only differed in casing from the language value, a search and replace wouldn’t find the value,
unless the Match case option was deselected.

7097

A field in a Word template was not filled when the relevant
field name ended with "default".

7103

In the Hierarchy browser sometimes a '+' sign appeared
in front of a record that has no narrower records.

7104

Images imported into the Picturae DAMS, using import.exe, were not copied to the DAMS and didn’t receive
a uuid.

7115

In Adlib Designer, an unhandled exception occurred when
trying to add a new merge field.

7123

In Adlib Designer, the Translations manager didn’t monitor changes in texts from a .txt file, so you couldn’t save
them.

7124

After opening one of the lowest level records in the Hierarchy browser, no record in there was highlighted by the
selection bar.

7129

No thumbnails were created from the Thumbnails tab in
the Media viewer when a record was opened in detailed
view. (Adlib should create thumbnail files for linked images also when the image is shown for the first time in the
Media viewer, in detailed display of a record.)

7131

When editing a field, the Add occurrence icon was greyed
out, even though the field was repeatable.
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7135

It wasn’t possible to create multiple occurences of the
Title and Description fields. An error 1011 would be generated.

7146

The Brief display didn't display the current location's context unless the current location field itself was also defined
on the Brief display.

7158

After saving a linked thesaurus record in a zoom screen, a
related object record was suddenly displayed.

7166

After ignoring an Adlib warning in the Search wizard (e.g.
the one saying that your search results will be no longer
available after opening another dataset) by clicking the
Next button before clicking OK in the warning, an incorrect message about missing indexes was generated.

7183

An image import crashed on the end statement in an after-read adapl.

7212

Adlib suddenly displayed the last record from the search
result when going into edit mode after resizing the Adlib
window.

7217

Moving a field in the Designer Screen editor required the
repositioning of all fields and labels on the screen about
2mm away from their original location.

7218

Adlib crashed after running the Change location procedure
on a copied record or it would display a different record.

7222

Adding a new field to the Linked field mapping of a field
definition in Designer, overwrote the first row of that
mapping.

7232

It was impossible to use a term search method on linked
fields when user was a member of different Active Directory groups. In an application with Specified rights, default
access rights None, application authentication method
Active Directory, a user who is member of more than one
AD group which gives him a role in the application, it was
impossible to find values in linked fields using an access
point. As a result of this issue, Copies records linked to a
Document record were deleted by the storage adapl when
saving the Document record.

7233

A user with Write (not Full) access rights couldn’t copy
records: the Copy icon seemed to be active, but didn't
work.
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7258

Setting a specific occurrence for a field in the hierarchy
browser didn’t work.

7263

A Change location action on multiple records created 13
empty occurences (occ 2-14) in the Location history field
group for all but the 1st record in the selection.

7265

Long role names in the Edit role dialog for pointer file access rights, were cut off because of the fixed width of the
Role drop-down list.

The Edit role window, and with it the Role drop-down list,
is now resizable by dragging the right edge of the window.
7266

A field = "*value1 value2*" Advanced search on a
free-text indexed field produced too many results.

7285

When using an adapl in an Advanced search statement, an
error 9 was generated.

7304

Reusing a pointer file number also reused the access
rights settings of the deleted pointer file.

7315

Locations were duplicated in the Find data for the field
window for the Change locations procedure and the value
was not copied to the Change locations form.

7346

Using a search method to search a newly created ISO date
index resulted in an Invalid descriptor index error message. Deleting the index and recreating it did not correct
the problem.
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7347

Screens that had been turned off (hidden) were turned on
again when a record was put into edit mode.

7354

When a context field had been added to the format string
of the Internal link properties, it was still not displayed in
the Hierarchy browser.

7359

The pop-up menu Insert option in the Hierarchy browser
was not greyed out when the user didn’t have the proper
rights to insert a record.

7364

After opening a pointerfile on the Thumbnails tab of the
Brief display and subsequently sorting the result from the
menu, the list seemed to be put in the wrong order, and
sometimes results even seemed to be duplicated. However, if you clicked an object, you would actually see the
proper object.

7367

Adlib crashed when you navigated from a record in a record set to a related record and then used the Next record
icon or pressed F5.

7376

Stand-alone screen labels couldn't be conditionally suppressed like fields.

7418

A user with Read-only rights was still offered the possibility to add a term from another domain to the present domain, but on saving the record an error 58 was generated.

7438

A CSV export would only export the first record.

7440

An error 1011 was generated when using the Add occurrence below function on the Creator field.

7450

The Hierarchy browser sometimes showed the priref of the
broader record instead of the current term.

7458

A favourite value which had been added to a field’s favourites using Adlib 7.2 was not available when using 7.3.

7461

The Change location procedure didn’t copy the Normal
location to the Current location field, when the To normal
location checkbox had been marked.

7473

The Change location procedure didn't assign a new current
location for every second record.

7474

A stand-alone adapl couldn’t find an indexed date.
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7486

When adding an image and saving the record, an error
189: substituting preferred term was sometimes generated.

7489

Adloan sometimes crashed when connecting to the server.

7496

The Receive field in the Acquisition module was emptied
when leaving the field and the order status couldn’t be
changed.

7497

When in an adapl the FACS database CHARGING was being read, an error 55 was generated.

7505

After paying the total open loan fee using Adloan, the fees
record was removed, but the record lock for that record
number remained, causing an error 346 for the next Adloan user who wanted to create a new fees record.

7510

When using the derive function for the second time, not
all fields were copied to the record.

7514

Sometimes the Thumbnails and Filmstrip tabs in the Media
Viewer weren’t working: no thumbnails were shown.

7595

The Change location procedure didn’t work when you used
a term from the Find data for the field list to search for a
location.

7602

During the import of images, file names were always converted to uppercase.

7635

Repeated searching in an application with an image handler was often very slow and could make Adlib freeze up.
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